KCCD Operational Data Store (ODS)
Discoverer Quick Reference Guide

Presented in 2 Formats:

1. Quick Reference Guide (pages 2-7) includes helpful screen shots to guide you
through the login, data retrieval and exporting processes.

2. Quick Reference Card (page 8) is a one page summary of the Guide

Last Updated: January 2013

Recent Additions:
e Updated login process (page 2)
e Tip: Password synchronization (page 2)
e Tip: Viewing Reports on Screen Easier (page 4)

e Tip: Formatting Problems when Importing to Excel 2007 (page 6)

What is ODS vs. Discoverer?

e ODS (Operational Data Store) is a data base where Banner data is copied and
optimized for reporting. The data in the ODS is not ‘live’ like Banner but it is
updated each night.

e Discoverer is a reporting tool used to access the data in the ODS.

Institutional Research and Reporting 1 Last Updated: January 2013



KCCD Operational Data Store (ODS)
Discoverer Quick Reference Guide

Logqing into Discoverer:

1. From within an internet browser go to the Discoverer Plus login page at:

https://reporting.kccd.edu/discoverer/plus

Note: Please make sure that the pop-up blocker on your internet browser is turned off. (In
Internet Explorer, the pop-up blocker toggle is in the Tools drop-down menu across the top.)

Tip: Add a bookmark to the site so you can easily return. (In Internet Explorer, add a bookmark by
selecting Add to Favorites in the Favorites drop-down menu across the top.)

2. The web address above takes you to the Discoverer Plus Login Screen (Figure 1).

3. Enter your login information.

a) Username - Your user name should
match your Banner username (for

example, jsmith).

b) Password - If this is your first time
logging in, your password should match
your synchronized network\Banner\
email password. In some cases, it is set
to CHANGEME, in which case you will be

prompted to change your password.

Tip: If your passwords need to be
synchronized, use the following url:
http://uam.kccd.edu/. This website will
synchronize your passwords and/or let you
change them.

Database - Enter ODS

c)

g Comnect to DisECIVEI'EI“— v

il https://reporting.kecd.edu/discoverer/plus

File Edit View Favorites Tools Help

7.7 Favorites il Connect to Discoverer - E
ORACLE  Discoverer Plus
Business Intelligence

Connect to OracleBl Discoverer
Welcome to OracleBl Discoverer.

Connect Directly
Enter your connection details below to connect directly to OracleBl Discoverer.

* |ndicates required field.
Connect To OracleBl Discoverer -
* Lser Name jsmith
* Password esesssss
* Database ods
End User Layer

Locale Locale retrieved from browser -

d) Leave the £End User Layer blank and do not select a Locale.

Note: Login information is not case sensitive.

4. C(Click the 6o button.

Note: During your first login, if your machine
doesn't have a Java Runtime Engine, there will be
a delay while one is installed. Follow any
instructions to complete the process as they
appear.

Security Information

X]

rir“l _This pade cohtaing bath secure and nonzecure
?. ikermns.
Do you want to dizplay the nonzecure ikems?
| Yes | [ Mo ] [ Mare [nfa
Figure 2

5. Click YES when the Security Information window appears (see Figure 2).
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6. Click YES if the Warning - Security window

appears (see Figure 3)

(Figure 4)

Opening a Workbook/Report

You are now logged into ODS Discoverer and
you will see the Workbook Wizard screen

Warning - Security

Do you want to trust the signed applet distributed by "Oracle Corparation”?

Fublizher authenticity verified by: "WeriSign, Inc."

he security cerificate was issued by a company that is trusted.

he security cedificate has not expired and is still valid.

accept this content if you trust"Oracle Corparation” to make that assertion.

| Yes || Mo || Always |

Caution: "Oracle Corporation” assers that this content is safe. You should only

Mare Details

3

Figure 3
1' Fr‘om The WOf'kbOOk M//'Za/‘d screen 2 Workbook Wizard - Step 1 of 5: Create/Open Workbook (‘5__<|
(Flgure 4)’ seleCT Opeﬂ a” EX/Sr/ﬂ-q Connected to the Database: 0DS31 (EULODSEUL)
WaﬁkbOO/(' What do you want to do?
" Open an existing workhook 4—
H Recenty Used
2' CIICk Br‘owse There are no recently used workhooks Ia_mwgg__
3. You will now see the Open
Workbook from Database screen =
electthe objects to display in the workshest
(Figur‘e 5) W Tile Example
M .
3 I+ Page ltems <] <] <]
\ C Crogetab  ® Tahle i i I}
If you do not see a list of hames @ W orach ———

d Business A 7 ™
and Business Areas (e.g. ot —
Student_Sched), click the drop-
down list next to the icon as
indiCGTCd in Figur‘e 5 and SeIeCT ( Help ( Properties... ( Shiow SAL.. ( Back: Mext )( Einish j( Cancal |
User Tree.

Figure 4
4. Flnd The BUSIneSS Ar‘ea or per‘Sonal 3 Open Workbook from Database

folder in which the report you want to
access is located and click the plus
sign next to it. This will open a list of
workbooks/reports to which you have
access.

Note the Name of the Personal Folder or
Business Area:

Institutional Research and Reporting

Wienw: [AII Workbooks

Workhooks:

Mame =

@ ANMORGAN

& & AUDITOR

= & LFITZGER

= & MEEAM

& @ MCARLEY

@ & MREGPALA

& & ODS_INFO

= & oDSEUL

& @ SJAMES

& & STUDENT_COUNSELOR
& & STUDENT_DISTANCE_ED
= & STUDENT_SCHED

@ wiorkbook Tree
@ Table

~Desctiption

[ Help )

( Qpen )( Cancel )I

Figure 5
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5. Click on the report you would like to access and then cli

Note the Name of the Report:

ck Open.

If the workbook/report has parameters (filters),
you will see the Edit Parameter Values screen
(Figure 6). Enter the Parameters as requested -
they will vary by report. Click OK'to enter the
criteria and run the report. You may get a message
indicating how long it will take to run the query and
asking whether you want to continue - Click Yes.

Note: The message indicating the amount of time it will
take to run the query is not always accurate.

Tip: If there is a flashlight icon next to the parameter

< Edit Parameter Values

(circled on Figure 6), click on it to select options from a
list rather than typing in the criteria.

2) Workhaok 3 - OracleBI Discoverer - Micrasoft Internet Explorer

If no data is returned

File Edit Wiew Format Tools Help

Selectvalues for the following parameters: N
[
Selec Ternr [200830° UE )
Colege™  [BC, PC, 00" ¥
rDescription ‘
* indicates required field.
Belp i Cancel

Figure 6

or if you want to ewvosan.omeaN =% % . ¥%.0 88
select new parameter A[“_“ifa; Foie:ui=sxz@ei o2 BB BE
values (ex. a different "a'? e\fms& Y S WEAD Double-click here to edit the title
term), click the arrow _ Fage fem:
button as indicated in L@'éf‘ft '@: cadamic_Poros
Figure 7 to refresh’ | || revarere
the workbook. g Eiiilliii_m
- [gh Campus
Discoverer will only E %Eg:m:pi:
retrieve the first ; FEEZEZEEZZE -~
250 rows of data. If & Guoweon
there is more data, S .
you will need to click Seleted llems
Retrieve All Rows in @{; A;emi;ﬁu EJ
the Tools drop-down i R
menu across the top.
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Tip: Repor‘TS are easier  Enrollment Activity After-Term - OracleBl Discoverer - Windows ( KAIEY ) :HE‘E
to view if the design

File Edit nols  Help

I+ Available ltems Pane

; T8 B HIR % &% @18 M
: G
panes, in the left Doy g ectes lems Pane / Rel . ow BB B
por"ﬂon of the page, Availagls 1 Status Bar Enroliment Activity {After-Term) by Course with Multiple Terms 2
= M Tille se 1) College : 'BC' , Term : '200850, 200750°
e __ W,

are r'emoved fr'om - Course Information Shown in Multiple Terms
Ite [ Crosstab Mote: Fill Rate = Census Envoliment/Max Seats - Max Seats incarporates both curriculum and facility :
e

view. This can be et [@ 0% 5= o

Graph Placement  » Page Items: HStatus Active v||-| Campus: =All= vH-| Division: <Al vH_| Dept: =4l v‘ Subj: SPST
_l .

ions

. . E (=]
done by cllckmg on | O Textare Jr Term|r 200750 v
EE CUSTETHITE TRy — . Sections [X-Listed| Max |Census FillRate | Actual | FTEF | FTES/ Se
/, G Ir_Course_Catalog - Groups | Seats | Enrollmt FTES FTEF
the View menu across = .
et ¥ SPSTB20IL 1 100 1 1% 0g 02
the Top Gnd P n_s=ction ¥ SPSTB40 3 70 w0 5% 24| oa| o
&> JfﬁAcauemw_Permd ¥ SPSTEB49 2 2 3 150% 0z 00
H H > Acadermic Period D ¥ SPSTB4SL 4 2 i El 42% 49 05 EE)
unselec.“ng the flr‘s.r & ;CEUEHEZ:IE’ Brioa_bese Sum 10 2 246 75 30% 75 0.8 9.4
0
two items - Avarlable o LixColegs_pese
> fﬁcampus
Items Pane and & I3 Compus_Dess
ot 2L Babimet =

Selected Items Pane
Selected lterns:
as shown in Figure 8. s w0 (=) E : >
. fa T Ecampus EDeptrSubj course u erm ECourseLookup EXHS!LDDKUD
Figure 9 shows the ; |
same report viewed in Figure 8
full screen mode.

& Enrollment Activity After-Term -

File Edit Yiew Format Tools Help
LW SE B.DHWI P9I n B =IH %S E.T N

Dialog 11 Bl ulEls =R, 22 B BI& &)

Enrollment Activity (After-Term) by Course with Multiple Terms
College : 'BC', Term : '200850, 200730
Course Infermation Shown in Multiple Terms
MNote: Filf Rate = Census Enroliment/ Max Seals - Max Seatsincorporates hoth curriculum and facility considerations
Pogo tme: ] acve [ conps: < ] o <as ot - |
- r Term|r 200750 4 200850
. Sections X-Listed| Max Census |FillRate  Actual FTEF FTES/ Sections X-Listed Max Census  Fill Rate | Actual FTEF | FTES/
Groups | Seats | Enrolimt FTES FTEF Groups | Seats  Enrolimt FTES FTEF

-|  Course
¥ SPSTB201L] 1 100 1 1% oo 0z 1 25 3 12% oo oo
I SPSTB43 3 70 40 5% 24 01 2.0 1 5 1 20% 04 0.0
¥ SPSTB4Y 2 2 3 130% 0z 0o 2 &} il 3% 04 0.0
¥ SPSTB4IL 4 2 T4 Ell 42% 48 05 EE] 3 1 15 30 200% 26 04 64

Sum 10 2 246 75 30% 15 0.8 8.4 7 1 51 3 6% 31 0.4 7.6

[ ID
ﬁcampus EDEDI—SUEJ fcourse Mcourse Lookup EX\\sthnkup
Figure 9
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Exporting Data from Your Discoverer Workbook/Report

1' If you WOLI|d “ke 2 View - CSCD - OracleB| Discoverer - Microsoft Internet Explorer \:”szq
lﬂu Edit wiew Farmat Tools Help
to export your K o | D M0 al Q180 & =15, %, &, %. B/ 8 &
data to another S T™ruiszIERI 20 BB IBY
program such as EZ:EAS s Double-click here to edit the title
: '
Excel' CIICk on E,{Dm HTML College Academic Period Method_Of_Aftend_Dest  Census Enroll Actual FTES Estimated FTES  Section_Spcl_&pm_Cc
File across the Exportto Excel ElE
— || 2
top and select spare. 3
Page Setup... 4
EXpOI‘f (see Print Preyiew g
Figur‘e 10) Print Ctri+P 5
Wiorkbook Properties 7
Exit a
. ! &
Note: If's better —
to select Export 1
rather than —
13
Export-to-Excel T
because that - - -
Op.Hon GIIOWS YOU Selected ftams: oThe data for this sheat has notyet been queried. Use the Refresh Sheet command inthe Tools menuto run the query.
F 7 &
to select the name | =~ 0 [E7]
mCollege =
Of your‘ dGTG Ond oy#cadenic Period || Double-click here ta editthe text area
where to save it. g hethod_O7_Atend_Desc
1 Section_Spel_Aprv_Code
— MBIl Sheet |
( ‘ Exports the workbook to a new file format

Figure 10

2. You will now see the Export
wizard which will walk you 3 Export - Step 2 of 4: Format and Name
though 4 steps to export your
data.

\What export format do you want to use?

Table: [Microsnﬂ ExcelWiorkhook (".xls) '|

Where do you want to save the file?

Qestination:IC:xDocuments and Setlingsll ( Erowse... )

What do you want to name the file?

MName: IFiIe Export 4—

Step 1. Select Current
Worksheet and click Next.

Step 2 (see Figure 11): Click
Browse to select the directory

where you'd like to save your m
data and type in a name for v
your file. [ 4

Step 3: Enter the desired
parameters (this step may be |t ) (e [ wew ) (" Emen ) (_Concal
missing if the wookbook/report  Figure 11

does not include parameters).

Step 4: Select the Supervised option and click Finish. Once the export is complete, the
Export Log window will appear to indicate whether the report was successfully exported.
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Microsoft Excel G= - = <

View ASAP Utiities Acrobat L

Tip: When importing data to Excel 2007,
the formatting may not transfer unless
you set Excel to enable Macros. You can B 3 oo escccrcim

4 320 Templates BCxiox (a o

do this in one of two ways. For both : i o ATy e B

f Jobis and Industry CTE Data (Marckeds =

options, click the Office button in the top R, e | 2eaamoe "

Recent Documents

1 509 PROD 3rdWi Fri 2-6-06.% = 7 gt |

§ E-ltablexis
left and select Excel/ Options (as depicted = i e e Gl
in Figure 12). s
_aa Seng v SubjDeptDean_Looklp s
e & e T
S09-508 15tDay Envoliment Comparisondse

R Project Tracking xdsm

Select the Trust Center from the choices

on the left in the Excel Options window

and then click Trust Center Settings Figure 12
(Figure 13).

Excel Options E|E|

In The TI"US"’ CenTer‘ . Cl ick Macf'o Se ff/hgs To Populde @ Help keep your documents safe and your computer secure and healthy.

Forrmulas

VI€W fhe OPTIOI‘IS (Flgur‘e 14). Procting Protecting your privacy

Microsoft cares abeut your privacy. For more information about how Microsaft Ofice Excel helps to

If Enable All Macros (fourth choice) is “m

selected, formatting will import S—
automatically. i

Resources

acy and security from Micrasoft Offce Onbine.

Microsoft Office Excel Trust Center

Trust Center F? x] Thee Trust Center cantains security and privacy settings. These settings heip ke
— Your comguter sedure. W recommend that you do not change these settings)

Trissted Publishers Macra Settings -
ok || Canest ]
Trusted Locations Far macras in documents not in a trusted location: e
@ Disable all macros without notification
Add-ins

@ Disable all macrog with notification Flgure 13

= Disable all macros except digitally signed macros

ActiveX Settings

© Enable all madros (not recommended: potentially dangerous code can run)

Macro Settings
Developer Macra Settings

Message Bar

[ Trust access to the YRA praject abject model
External Content

Privacy Options

o

Figure 14

fw) 509 PROD 2ndWk Tues 1 27-09.xIs [Compatibility Mode] - IEI=d) — = x
>
Home | Insert  Pagelayout Formulas Data  Review  View  ASAP Utilities Acrobat 4 — O X

If Disable All Macros with Notification P o S e g S 3 Ay
(second option) is selected, the file will el D IRl Lo e LT e | e s

. . . . Bl A IEE @ 0 ‘b {Elrormat - || 2.~ Filter = Select
import without formatting but you willbe  coo. — o g S | e caing
given an option (Figure 15) to S dBBYE 9 ¢ JETE%UAI TR %
e @ Security Warning Macros have been disabled Opligns

enable the macro. Click on Options : L b s _

. | Al > g _.!7 | Status desciactive %]

and select Enable this Content and the Pl 5 [ c | o [ e [ F e[ w4 [ €[@ Lul iy
2

ims sed Actre

for‘maf*ing wil | appear‘. 3 |Academic College Sectons Cument EnCensus Eriew FTES Ol FTES Est

4 Topazn cc 652 1319 13163 1434845 1900.59
& Tanpam BC 1886 0585 50217 BOBZ 9T B117.3%
B 00 PC 520 14254 14753 1584 TR 2648 THT
8
M 4 b W Summary By Campus By Acct Meth By Dept By Dept Suf
. ; = - -
Ready | Seroll Lok ] | 0 ] e [ (i

Figure 15
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KCCD Operational Data Store (ODS)
Discoverer Quick Reference Card

Site Location: https://reporting.kccd.edu/discoverer/plus

Login: User Name = Banner Username (i.e. jsmith, john.smith)

Password = Your chosen network/Banner/email password
Database = ODS
End User Layer = Leave Blank

Security Information Screen(s): Answer Yes
Open Workbook:

1.
2.

3.
4.

Click ‘Open an Existing Workbook’ and Click Browse
Select the ‘User Tree’ view to select reports shared with you from within personal
folders (i.e. mbeam) or business areas (i.e.Student_Sched)
Select the report you want to run; Click Open
Select/Enter Parameters, if requested (the flashlight icon allows you to choose from a list)

Retrieving Data:

1.
2.

3.

Click the Curved Arrow (refresh) icon across the top

Data may be limited to the first 250 lines. Click ‘Retrieve All Rows’ in the ‘Tools’
drop-down menu across the top to retrieve all data.

Click refresh to change parameter values (i.e. terms)

TIP: Hide the design panes to see more data on your screen — click ‘View’ on the menu bar and unselect

the first two items — “Available Items Pane” and “Selected ltems Pane”

Exporting Data:

1.

Click the ‘File’ menu item and select ‘Export’

2. Click Current Sheet (or Entire Workbook for all sheets)
3. Select a Destination for your file
4. Enter a Name for your file

TIP: When importing to Excel, if formatting is missing, be sure Macro settings are set to enable
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